
Q.1 पंडित छन्नूलाल मिश्रा, जिनका 89 वर्ष की आयु में निधन हो गया, निम्नलिखित में से किस हिंदुस्तानी
शास्त्रीय संगीत घराने से संबंधित थे?

Ans 1. बनारस घराना

2. जयपुर-अतरौली घराना

3. आगरा घराना

4. ग्वालियर घराना

Q.2 संविधान के  अनुच्छे द 280(1) के  अनुसार, वित्त आयोग का गठन __________ किया जाना होता है।
Ans 1. प्रत्येक तीन वर्ष में

2. प्रत्येक पांच वर्ष में या उससे पूर्व

3. प्रत्येक सात वर्ष में या उससे पूर्व

4. प्रत्येक चार वर्ष में या उससे पूर्व

Q.3 2025 में, कौन-सा भारतीय क्रिके टर देश के  लिए 50 टेस्ट मैच खेलने वाला पहला भारतीय तेज गेंदबाज
बन गया?

Ans 1. भुवनेश्वर कु मार

2. इशांत शर्मा

3. जसप्रीत बुमराह

4. मोहम्मद शमी

Q.4 पश्चिम बंगाल की कौन-सी लोक संगीत परंपरा, जो आध्यात्मिक विषयों  से संबंधित है, घुमंतू गायकों
(wandering minstrels) द्वारा प्रस्तुत की जाती है?

Ans 1. पांडवनी

2. बाउल

3. आल्हा

4. भवई

Q.5 निम्नलिखित में से कौन-सा, भारत में 1991 के  औद्योगिक सुधारों  का एक प्रमुख घटक नहीं  था?
Ans 1. एकाधिकार और प्रतिबंधात्मक व्यापार व्यवहार (MRTP) अधिनियम का उन्मूलन

2. उद्योगों का लाइसेंस रद्द करना

3. प्रमुख उद्योगों में सार्वजनिक क्षेत्र का विस्तार

4. प्रत्यक्ष विदेशी निवेश (FDI) को प्रोत्साहित करना
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Q.6 निम्नलिखित में से किस युग्म में शिखर और उनकी लगभग ऊँ चाई का मिलान गलत है?
Ans 1. अनाइमुडी - 2695 m

2. कं चनजंगा - 8598 m

3. नंगा पर्वत - 7026 m

4. डोडाबेट्टा - 2637 m

Q.7 भारतीय राष्ट्री य कांग्रेस का पहला अधिवेशन कब और कहाँ हुआ था?
Ans 1. 28 दिसंबर, 1885, पुणे

2. 28 दिसंबर, 1852, पुणे

3. 12 जनवरी, 1885, कलकत्ता

4. 28 दिसंबर, 1885, बंबई

Q.8 कोल विद्रोह, जिसने ब्रिटिश कानून और व्यवस्था के  हस्तक्षेप का विरोध किया, किस क्षेत्र में हुआ था?
Ans 1. बंगाल

2. छोटानागपुर

3. अवध

4. मैसूर

Q.9 भारत का संविधान निम्नलिखित में से किस प्रकार की नागरिकता को प्रतिबंधित करता है?
Ans 1. भारत के  क्षेत्र के  भीतर जन्म से नागरिकता

2. निर्धारित शर्तों को पूरा करने के  बाद देशीयकरण से प्राप्त नागरिकता

3. भारतीय नागरिकता के  साथ किसी अन्य देश की दोहरी नागरिकता

4. वैधानिक प्रावधानों के  अंतर्गत पंजीकरण द्वारा नागरिकता

Q.10 श्री सी. पी. राधाकृ ष्णन ने भारत के  _________ उपराष्ट्र पति के  रूप में शपथ ली।
Ans 1. 14वें

2. 13वें

3. 15वें

4. 12वें

Q.11 दी गयी अक्षर, संख्या और प्रतीक श्रृंखला का संदर्भ लें और निम्‍न प्रश्न का उत्तर दें। गिनती के वल बाएं  से
दाएं  ही करनी है।

(बाएं ) F 5 @ £ T 7 Y € V D © 3 € 6 % X 1 Z £ € G * (दाएं )

यदि श्रृंखला से सभी संख्याएँ  हटा दी जाएँ , तो निम्नलिखित में से कौन-सा, बाएं  से छठे  स्‍थान पर होगा?
Ans 1. Y

2. T

3. €

4. £

Q.12 निम्नलिखित त्रिक में, एक निश्चित तर्क  के  अनुसार प्रत्येक अक्षर-समूह अगले अक्षर-समूह से संबंधित है।
दिए गए विकल्पों में से उस विकल्प का चयन कीजिए जो समान तर्क  का अनुसरण करता है।
MAKE – MEKA – AEMK
LOAD – LDAO - ODLA

Ans 1. WIND – WDNI – IDWN

2. VIEW – WVIE – EWIV

3. GROW – ROWG – ORGW

4. RENT – RTEN – ENRT
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Q.13 सात व्यक्ति, C, D, E, F, W, X और Y, एक गोल मेज के  परित: कें द्र की ओर अभिमुख होकर बैठे  हैं। D के
बाएं  से गिनने पर C और D के  बीच के वल दो व्यक्ति बैठे  हैं। X, D के  ठीक दाएं  बैठा है। D और E के  बीच
के वल तीन व्यक्ति बैठे  हैं। F, W के  ठीक दाएं  बैठा है। F के  दाएं  से गिनने पर Y और F के  बीच कितने
व्यक्ति बैठे  हैं?

Ans 1. तीन

2. एक भी नहीं

3. एक

4. दो

Q.14 एक निश्चित कू ट भाषा में,

A + B का अर्थ है कि ‘A, B का पुत्र है’,
A – B का अर्थ है कि ‘A, B का भाई है’,
A x B का अर्थ है कि ‘A, B की पत्नी है’, और
A ÷ B का अर्थ है कि ‘A, B का पिता है’।

उपरोक्त के  आधार पर, यदि ‘L + M ÷ N x O – P’ है, तो L का P से क्या संबंध है?
Ans 1. भाई की पत्नी का पिता

2. पत्नी का पिता

3. भाई की पत्नी का भाई

4. पत्नी का भाई

Q.15 अंग्रेजी वर्णमाला क्रम के  आधार पर, निम्नलिखित चार अक्षर-समूहों  में से तीन एक निश्चित तरीके  से समान
हैं और इस प्रकार एक ग्रुप बनाते हैं। कौन-सा अक्षर-समूह उस ग्रुप से संबंधित नहीं  है?
(नोट: असंगत अक्षर-समूह, व्यंजनों /स्वरों की संख्या या उनकी स्थिति पर आधारित नहीं  है।)

Ans 1. MHJ

2. KEH

3. RMO

4. TOQ

Q.16 M, N, O, P, Q, R और S में से प्रत्येक व्यक्ति सोमवार से शुरू होकर रविवार को समाप्त होने वाले उसी
सप्ताह के  अलग-अलग दिनों  में एक खेल खेलता है। M बुधवार को खेल खेलता है। M और Q के  बीच
के वल दो ही व्यक्ति खेल खेलते हैं। O, R से ठीक पहले वाले दिन खेलता है, लेकिन गुरुवार को नहीं । N
और S के  बीच के वल दो ही व्यक्ति खेल खेलते हैं। N अंतिम दिन खेल नहीं  खेलता है। P किस दिन खेल
खेलेगा?

Ans 1. गुरुवार

2. मंगलवार

3. सोमवार

4. शुक्रवार

Q.17 निम्नलिखित संख्या और प्रतीक श्रृंखला का संदर्भ लें और दिए गए प्रश्न का उत्तर दें। गिनती के वल बाएँ  से
दाएँ  की जानी है। सभी संख्याएँ  एकल-अंकीय संख्याएँ  हैं।

(बाएँ ) 9 1 @ $ 5 1 # 5 9 $ 1 & 4 + 7 = ! 5 & 4 ? (दाएँ )

ऐसे कितने प्रतीक हैं जिनमें से प्रत्येक के  ठीक पहले एक संख्या है और उसके  ठीक बाद भी एक अन्य
संख्या है?

Ans 1. तीन

2. पाँच

3. चार

4. छह
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Q.18 एक निश्चित तर्क  के  अनुसार, 19 का संबंध 64 से है। इसी तर्क  के  अनुसार, 28 का संबंध 91 से है। इसी
तर्क  का अनुसरण करते हुए, 44 का संबंध निम्नलिखित में से किससे है?

(नोट: संख्याओं को उनके  घटक अंकों  में तोड़े बिना संक्रियाएं  पूर्ण संख्याओं पर की जानी चाहिए।
उदाहरण के  लिए 13 लीजिए, 13 पर संक्रियाएं  जैसे 13 में जोड़ना/घटाना/गुणा आदि की जा सकती है। 13
को 1 व 3 में तोड़ना तथा फिर 1 व 3 पर गणितीय संक्रियाएं  करने की अनुमति नहीं  है।)

Ans 1. 193

2. 139

3. 131

4. 113

Q.19 एक निश्चित तर्क  अनुसरण करते हुए 10 का संबंध 22 से है। उसी तर्क  का अनुसरण करते हुए, 24 का
संबंध 50 से है। उसी तर्क  का अनुसरण करते हुए, 6 का संबंध दिए गए विकल्पों में से किससे है?
(नोट: संख्याओं को उनके  घटक अंकों  में तोड़े बिना, पूर्ण संख्याओं पर संक्रियाएं  की जानी चाहिए।
उदाहरण के  लिए 13 लीजिए, 13 पर संक्रियाएं  जैसे कि 13 में जोड़ना/घटाना/गुणा करना, किया जा
सकता है। 13 को 1 और 3 में तोड़ना तथा फिर 1 और 3 पर गणितीय संक्रियाएं  करने की अनुमति नहीं
है।)

Ans 1. 12

2. 18

3. 14

4. 16

Q.20 विजय बिंदु  A से ड्रा इव करना प्रारंभ करता है और उत्तर की ओर 10 km ड्रा इव करता है। वह बाएँ  मुड़ता
है और 4 km ड्रा इव करता है, फिर से बाएँ  मुड़ता है और 12 km ड्रा इव करता है। वह फिर से बाएँ  मुड़ता
है और 9 km ड्रा इव करता है। वह अंतिम बार बाएँ  मुड़ता है और 2 km ड्रा इव करके  बिंदु  P पर रुक जाता
है। बिंदु  A पर वापस पहुँचने के  लिए उसे कितनी दू र (न्यूनतम दू री) और किस दिशा में ड्रा इव करना
चाहिए? (जब तक निर्दिष्ट न किया जाए, सभी मोड़ के वल 90 डिग्री के  मोड़ हैं)

Ans 1. 4 km, पूर्व की ओर

2. 5 km, पश्चिम की ओर

3. 5 km, पूर्व की ओर

4. 4 km, पश्चिम की ओर

Q.21 यदि ‘+’ और ‘-’ को परस्पर बदल दिया जाए तथा ‘x’ और ‘÷’ को परस्पर बदल दिया जाए, तो निम्नलिखित
समीकरण में ‘?’ के  स्थान पर क्या आएगा?

297 x 11 - 17 ÷ 18 + 91 =?
Ans 1. 248

2. 245

3. 240

4. 242

Q.22 उस त्रिक का चयन कीजिए जो नीचे दिए गए दो त्रिकों  के  समान पैटर्न का अनुसरण करता है। दोनों  त्रिक
समान पैटर्न का अनुसरण करते हैं।

HN-JF-MO
MS-OK-RT

Ans 1. PV-RN-UW

2. PU-SN-WY

3. PV-SN-UY

4. OU-SM-WY
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Q.23 निम्नलिखित संख्या और प्रतीक श्रृंखला का संदर्भ लें और फिर नीचे दिए गए प्रश्न का उत्तर दें। गिनती के वल
बाएं  से दाएं  की जानी चाहिए।

(बाएं ) 1 3 € £ 7 4 6 ¥ 2 8 $ 6 3 1 ◇ 1 3 9 ○ 2 5 ☆7 5 9 (दाएं )

ऐसे कितने प्रतीक हैं जिनके  ठीक पहले एक विषम संख्या है लेकिन ठीक बाद एक सम संख्या नहीं  है?
Ans 1. दो

2. तीन

3. एक

4. चार

Q.24 एक प्रश्न के  बाद दो कथन I और II दिए गए हैं। आपको यह तय करना है कि कथनों  में दी गई जानकारी
प्रश्न का उत्तर देने के  लिए पर्याप्त है या नहीं । दोनों  कथनों  को पढ़िए और सबसे उपयुक्त उत्तर चुनिए।

छह व्यक्ति, A, B, C, D, E और F, एक सीधी पंक्ति में उत्तर दिशा की ओर अभिमुख होकर बैठे  हैं। E के
ठीक बाएं  कौन बैठा है?

I. B, C के  दाएं  चौथे स्थान पर बैठा है। C और F के  बीच के वल एक व्यक्ति बैठा है। D, F के  दाएं  तीसरे
स्थान पर बैठा है।
II. C पंक्ति के  बाएं  छोर पर बैठा है। C और E के  बीच के वल दो व्यक्ति बैठे  हैं। A, D के  बाएं  चौथे स्थान
पर बैठा है।

Ans 1. कथन I और II दोनों में दिए गए डेटा संयुक्त रूप से भी प्रश्न का उत्तर देने के  लिए पर्याप्त नहीं  हैं।

2. कथन II में दिया गया डेटा अके ले प्रश्न का उत्तर देने के  लिए पर्याप्त है, जबकि कथन I में दिया गया डेटा अके ले प्रश्न का उत्तर देने के  लिए पर्याप्त नहीं
है।

3. कथन I में दिया गया डेटा अके ले प्रश्न का उत्तर देने के  लिए पर्याप्त है, जबकि कथन II में दिया गया डेटा अके ले प्रश्न का उत्तर देने के  लिए पर्याप्त नहीं
है।

4. कथन I और II दोनों में दिए गए डेटा संयुक्त रूप से (स्वतंत्र रूप से नहीं ) प्रश्न का उत्तर देने के  लिए पर्याप्त हैं।

Q.25 एक निश्चित तरीके  से LF 58 का संबंध ID 49 से है। उसी प्रकार, YK 36 का संबंध VI 27 से है। उसी तर्क
का अनुसरण करते हुए, RO 61 का संबंध निम्नलिखित में से किससे है?

Ans 1. OV 53

2. OH 59

3. OM 52

4. OG 55

Q.26 एमएस वर्ड 2021 में टेबल में पंक्तियों  और स्तंभों  को इन्सर्ट करने और डिलीट करने के  संबंध में
निम्नलिखित कथनों  पर विचार करें :
टैब कुं जी का उपयोग करके  के वल टेबल के  अंत में नई पंक्तियाँ इन्सर्ट की जा सकती हैं।
टेबल टू ल्स के  अंतर्गत लेआउट टैब उपयोगकर्ताओं को टेबल के  भीतर किसी भी स्थान पर पंक्तियों  और
स्तंभों  को इन्सर्ट करने या डिलीट करने की सुविधा देता है।
राइट-क्लिक कॉन्टेक्स्ट मेनू पंक्तियों  या स्तंभों  को इन्सर्ट करने या डिलीट करने के  लिए त्वरित विकल्प
प्रदान करता है।
उपरोक्त कथनों  में से कौन-सा/से कथन सही है/हैं?

Ans 1. के वल कथन 1 और कथन 3

2. कथन 1, कथन 2 और कथन 3

3. के वल कथन 2 और कथन 3

4. के वल कथन 1 और कथन 2

Q.27 क्लिप आर्ट में _________ शामिल हैं।
Ans 1. सिर्फ़  चार्ट

2. साउंड फ़ाइलें

3. एनिमेटेड GIF और ड्रॉ इंग

4. सिर्फ़  वीडियो

Section : Basics of Computers and Application
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Q.28 एमएस एक्सेल में, कौन-सा विकल्प आपको कॉलम B और C के  बीच एक नया कॉलम इन्सर्ट करने की
सुविधा देता है?

Ans 1. कॉलम C चुनें → Delete दबाएँ

2. "क्लियर कं टेंट्स (Clear Contents)" ऑप्शन का इस्तेमाल करें

3. कॉलम C हेडर पर राइट-क्लिक करें  → Insert

4. कॉलम B हेडर पर राइट-क्लिक करें  → Delete

Q.29 एमएस वर्ड 365 में माउस को ड्रै ग किए बिना पूरे  वाक्य को चुनने के  लिए कौन सा शॉर्टकट काम आता
है?

Ans 1. Ctrl + वाक्य में कहीं  भी क्लिक करें

2. Ctrl + Shift + End

3. Ctrl + Click

4. Ctrl + Shift + →

Q.30 आपके  पास Word में पेस्ट किया हुआ एक बड़ा, कॉमा से अलग किया हुआ डेटा सेट है, जहाँ हर लाइन
एक नई पंक्ति दर्शाती है और कॉमा (,) उस डेटा को अलग करते हैं जिसे अलग-अलग सेल में होना
चाहिए। इस टेक्स्ट को सही तरीके  से टेबल में बदलने के  लिए, यह पक्का करते हुए कि डेटा सही तरीके  से
पार्स हो, Microsoft 365 में MS Word का इस्तेमाल करते समय आपको कौन से काम करने हों गे?

Ans 1. पूरे  टेक्स्ट को सेलेक्ट करें , इन्सर्ट टैब पर जाएं , टेबल पर क्लिक करें  और क्विक टेबल्स चुनें, फिर उपयुक्त स्टाइल चुनें।

2. पूरे  टेक्स्ट को सेलेक्ट करें , लेआउट टैब (टेबल टू ल्स के  अंतर्गत) पर जाएं , टेक्स्ट डायरेक्शन चुनें और कन्वर्ट टेक्स्ट टु टेबल ऑप्शन चुनें।

3. पूरे  टेक्स्ट का चयन करें , टेबल प्रॉपर्टीज़ डायलॉग बॉक्स खोलें, रो टैब पर जाएं  और पंक्ति की एक निश्चित ऊं चाई निर्दिष्ट करें , जिससे रूपांतरण
स्वचालित रूप से शुरू हो जाएगा।

4. पूरे  टेक्स्ट को चुनें, इन्सर्ट टैब पर जाएं , टेबल पर क्लिक करें  और कन्वर्ट टेक्स्ट टु टेबल चुनें, फिर पुष्टि करें  कि विभाजक वर्ण अल्पविराम पर सेट है।

Q.31 निम्नलिखित में से कौन-सा सामान्यतः  प्रयुक्त इंटरनेट सेवाओं और उनके  प्राथमिक कार्यों का सही
संयोजन है?

Ans 1. FTP - वेबसाइट ब्राउज़ करना; Email - लाइव चैटिंग; VoIP - फ़ाइलें प्रिंट करना

2. FTP - फ़ाइलें स्थानांतरित करना; VoIP - ध्वनि संचार; Email - संदेश भेजना और प्राप्त करना

3. Email - दू रस्थ पहुँच; WWW - फ़ाइल एन्क्रिप्शन; FTP - हार्डवेयर ड्रा इवरों का प्रबंधन

4. WWW - फ़ाइल स्थानांतरण; Email - वास्तविक समय वीडियो कॉलिंग; Telnet - फ़ोटो भेजना

Q.32 निम्नलिखित में से कौन-सा विकल्‍प कं प्यूटर सिस्टम में PCB की भूमिका का सबसे अच्छा वर्णन करता है?
Ans 1. इलेक्ट्रॉ निक घटकों को जोड़ने वाला एक भौतिक बोर्ड

2. वायरलेस नेटवर्क  में प्रयुक्त एक प्रोटोकॉल

3. डेटा स्थानांतरित करने के  लिए एक इनपुट डिवाइस

4. वायरस हटाने के  लिए एक सॉफ्टवेयर टू ल

Q.33 एक्सेल या ऑफिस एप्लिके शन में कौन-सा टू लबार आपको आकृ तियाँ, तीर और फ्लोचार्ट तत्व बनाने की
सुविधा देता है?

Ans 1. स्टैंडर्ड टू लबार (Standard Toolbar)

2. फ़ॉर्मेटिंग टू लबार (Formatting Toolbar)

3. फ़ॉर्मूला टू लबार (Formula Toolbar)

4. ड्रा इंग टू लबार (Drawing Toolbar)

Q.34 R1C1 रेफरेंस स्टाइल में, Microsoft Excel 2021 में कॉलम E और पंक्ति 8 पर स्थित सेल को कै से
दर्शाया जाता है?

Ans 1. 8R5C

2. R8C5

3. RC85

4. 8RC5
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Q.35 विंडोज़ एक __________ के  साथ आता है जो वर्तमान में खुले हुए प्रोग्राम प्रदर्शित करता है। यह
उपयोगकर्ताओं को किसी भी विशिष्ट प्रोग्राम तक पहुँचने की भी सुविधा देता है।

Ans 1. फ़ाइल एक्सप्लोरर (file explorer)

2. टास्क मैनेजर (task manager)

3. टास्कबार (taskbar)

4. स्टार्ट मेन्यू (start menu)

Q.36 सिस्टम सॉफ्टवेयर घटक _____ कं प्यूटर सिस्टम को बूट करने के  लिए जिम्मेदार है।
Ans 1. CLI/GUI

2. CGI/ETF

3. BIOS/UEFI

4. HDMI/VGA

Q.37 एक क्लाईंट से संवेदनशील जानकारी वाला ईमेल प्राप्त हुआ है। इसे आगे की कार्रवाई के  लिए एक
सहकर्मी को अग्रेषित करना आवश्यक है। इस प्रक्रिया के  दौरान संवेदनशील जानकारी की सुरक्षा के  लिए
क्या उपाय किए जाने चाहिए?

Ans 1. संवेदनशील जानकारी वाले ईमेल को डिलीट करें।

2. ईमेल को बिना किसी बदलाव के  आगे भेज दें।

3. आगे भेजने से पहले संवेदनशील जानकारी को संपादित कर लें।

4. अपने सहकर्मी को फोन करें  और मौखिक रूप से संवेदनशील जानकारी साझा करें।

Q.38 इष्टतम डॉक्यूमेंट प्रिंटिंग परिणामों  के  लिए किन कारकों  पर विचार किया जाना चाहिए?
Ans 1. सेटिंग्स की परवाह किए बिना सभी डॉक्यूमेंट एक समान प्रिंट होते हैं।

2. प्रिंटिंग सेटिंग्स का अंतिम परिणामों पर कोई प्रभाव नहीं  पड़ता।

3. प्रिंटर का चयन, कागज़ का प्रकार, प्रिंट गुणवत्ता, रंग विकल्प तथा पेज रेंज सेटिंग्स, प्रिंटिंग के  परिणामों तथा संसाधन दक्षता को प्रभावित करते हैं।

4. डिफ़ॉल्ट मुद्रण सेटिंग्स सदैव उपयुक्त होती हैं।

Q.39 विंडोज ऑपरे टिंग सिस्टम में, ओपेन प्रोग्रामों  के  बीच नेविगेट करने हेतु किस शॉर्टकट कुं जी का उपयोग
किया जाता है?

Ans 1. Alt + F4

2. Alt + Ins

3. Alt + Del

4. Alt + Tab

Q.40 आप अपने प्रेजेंटेशन के  डिज़ाइन टेम्पलेट को बदलने के  विकल्प कहाँ पा सकते हैं?
Ans 1. व्यू टैब (View tab)

2. इन्सर्ट टैब (Insert tab)

3. डिज़ाइन टैब (Design tab)

4. होम टैब (Home tab)

Q.41 ईमेल में रिप्लाई और फॉरवर्ड में क्या अंतर है?
Ans 1. रिप्लाई ईमेल को एन्क्रिप्ट करता है, जबकि फॉरवर्ड ऐसा नहीं  करता।

2. रिप्लाई करने पर ईमेल सभी संपर्कों को भेजा जाता है, जबकि फॉरवर्ड करने पर किसी को नहीं  भेजा जाता।

3. रिप्लाई विकल्प आपके  जवाब को के वल मूल प्रेषक को भेजता है, जबकि फॉरवर्ड विकल्प ईमेल को एक नए प्राप्तकर्ता को भेजता है।

4. रिप्लाई करने से मूल संदेश डिलीट हो जाता है, जबकि फॉरवर्ड करने से वह सेव हो जाता है।
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Q.42 एमएस पावरपॉइंट में, कौन-सा फीचर एमएस वर्ड या एमएस एक्सेल से तालिकाओं को इन्‍सर्ट करने में
सक्षम बनाता है?

Ans 1. Home > Table

2. Insert > Object

3. File > Import

4. Insert > Table

Q.43 एमएस वर्ड में पावर सेविंग मोड के  बारे  में निम्नलिखित में से कौन-सा कथन सत्य है?
Ans 1. MS Word में एक खास “Power Saving Mode” है जो CPU का इस्तेमाल कम करता है और एडिटिंग फीचर्स को बंद कर देता है

2. वर्ड में पावर सेविंग मोड चालू करने से प्रिंटिंग और स्पेल-चेकिं ग हमेशा के  लिए बंद हो जाती है

3. वर्ड में पावर सेविंग मोड एनर्जी बचाने के  लिए सभी डॉक्यूमेंट्स को अपने आप प्लेन टेक्स्ट में बदल देता है

4. जब कं प्यूटर का पावर-सेविंग मोड चालू होता है, तो MS Word अपने आप परफॉर्मेंस को एडजस्ट करता है और बैकग्राउंड ऑपरेशन को कम करता
है

Q.44 अधिकांश ई-मेल क्लाइंट में उपयोगकर्ता ई-मेल में फ़ाइल किस प्रकार अटैच
(attach) कर सकता है?

Ans 1. Edit मेनू पर जाएँ  तथा 'Add File' सिलेक्ट कीजिए

2. फ़ाइल अटैच करने के  लिए Ctrl + A दबाएँ

3. 'Send' बटन पर क्लिक कीजिए तथा एक फ़ाइल सिलेक्ट कीजिए

4. 'Attach File' या पेपरक्लिप आइकन पर क्लिक कीजिए तथा एक फ़ाइल सिलेक्ट कीजिए

Q.45 स्विच्ड ईथरनेट लैन में, कौन-सी स्विचिंग विधि गंतव्य मैक एड्रे स पढ़ते ही फ्रे म को अग्रेषित करना शुरू
कर देती है, जिसके  परिणामस्वरूप सबसे कम विलंबता होती है लेकिन करप्टेड फ्रे म अग्रेषित करने का
जोखिम अधिक होता है?

Ans 1. स्टोर-एं ड-फॉरवर्ड स्विचिंग

2. कट-थ्रू स्विचिंग

3. फ्रै गमेंट-फ्री स्विचिंग

4. टोकन पासिंग

Q.46
यदि E और F दो परस्पर अपवर्जी घटनाएँ  हैं जैसे कि  और  है, तो P(न तो E

और न ही F) ज्ञात कीजिए।
Ans

1. 

2. 

3. 

4. 

Q.47 (2.5 × 0.48 ÷ 0.6) + (3.5 + 1.6 ÷ 0.8) − (4.8 × 0.25 ÷ 0.8) को सरल कीजिए।
Ans 1. 8

2. 6

3. 7

4. 5

Section : Mathematics
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Q.48 यदि a = 18 और d = 30 है, तो समांतर श्रेढ़ी (A.P.) के  प्रथम 6 पदों  का योगफल ज्ञात कीजिए।
Ans 1. 559

2. 555

3. 561

4. 558

Q.49 x-अक्ष पर स्थित उस बिंदु  P के  निर्देशांक ज्ञात कीजिए जो बिंदुओं A(2,3) और B(–4,5) से समान दू री पर
स्थित है।

Ans
1. 

2. 

3. 

4. 

Q.50 आकाश में एक पतंग उड़ रही है। एक व्यक्ति 40 m लंबी, कसकर खीं ची हुई डोर से पतंग को पकड़े हुए
है। यदि डोर क्षैतिज से 30 डिग्री का कोण बनाती है, तो पतंग की ऊं चाई (मीटर में) ज्ञात कीजिए।

Ans 1. 10

2. 15

3. 20

4. 30

Q.51 नीचे दी गई तालिका में छह विद्यार्थियों  द्वारा एप्टीट्यूड (aptitude) परीक्षा में प्राप्त अंक दर्शाए गए हैं।
आंकड़ों  का ध्यानपूर्वक अध्ययन कीजिए और नीचे दिए गए प्रश्नों  के  उत्तर प्रकारों  को सुमेलित कीजिए।

विद्यार्थी A B C D E F

अंक 48 50 52 55 60 65
निम्नलिखित को सुमेलित कीजिए। (मानक विचलन मानों  को दो दशमलव स्थानों  तक पूर्णांकित किया गया
है)
A. संपूर्ण डेटासेट का मानक विचलन I. 5.88
B. के वल मध्य के  चार मानों  (B, C, D, E) का मानक विचलन II. 3.77
C. के वल पहले तीन मानों  (A, B, C) का मानक विचलन III. 4.08
D. के वल अंतिम तीन मानों  (D, E, F) का मानक विचलन IV. 1.63

Ans 1. A − I, B − II, C − IV, D − III

2. A − II, B − IV, C − III, D −I

3. A − II, B − IV, C − I, D − III

4. A − I, B − II, C − III, D − IV

Q.52 यदि समीकरण  के  मूल  और  हैं, तो  का मान ज्ञात कीजिए।

Ans 1. 6

2. 13

3. 12

4. 5

Q.53 एक बेलनाकार स्तंभ का व्यास 28 cm और ऊं चाई 25 m है। स्तंभ के  वक्र पृष्ठ को ₹50 प्रति m2 की दर से
रंगने की लागत ज्ञात कीजिए।

 का उपयोग कीजिए)

Ans 1. ₹1100

2. ₹1138

3. ₹1072

4. ₹1080
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Q.54 यदि किसी समांतर श्रेढ़ी (AP) के  8वें और 12वें पदों  का योगफल 100 है, तथा 20वां पद 95 है, तो 7वां पद
ज्ञात कीजिए।

Ans 1. 36.5

2. 38.5

3. 39.5

4. 37.5

Q.55 दो संख्याओं जिनमें से प्रत्येक में तीन अंक हैं, का महत्तम समापवर्तक (HCF) 19 है और उनका लघुत्तम
समापवर्त्य (LCM) 760 है। ऐसे युग्मों  की संख्या ज्ञात कीजिए।

Ans 1. 1

2. 0

3. 3

4. 2

Q.56 समुच्चय S = {1, 2, 3, 4, 5, 6 ,7, 8} के  घात समुच्चय P(S) में अवयवों  की संख्या ज्ञात कीजिए।
Ans 1. 256

2. 258

3. 250

4. 247

Q.57 शीर्ष A(-16, 13), B(-2, -9) और C(2, 13) वाले त्रिभुज ABC के  कें द्रक का निर्देशांक ज्ञात कीजिए।
Ans

1. 

2. 

3. 

4. 

Q.58 एक टेस्ट में, क्रिस को दो सवालों  के  जवाब देने हैं। पहले सवाल का सही जवाब देने की उसकी प्रायिकता

 है। यदि वह पहले सवाल का सही जवाब देता है, तो उसके  दू सरे  सवाल का सही जवाब देने की

प्रायिकता  है। यदि क्रिस पहले सवाल का सही जवाब नहीं  देता है, तो उसके  दू सरे  सवाल का सही

जवाब देने की प्रायिकता है। क्रिस के  दू सरे  सवाल का गलत जवाब देने की प्रायिकता ज्ञात कीजिए।

[नोट: मान लीजिए कि प्रत्येक सवाल का जवाब - या तो सही या गलत दिया जाएगा।]
Ans

1. 

2. 

3. 

4. 
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Q.59 त्रिभुज ABC, त्रिभुज PQR के  समरूप है। AM और PS शीर्षलंब हैं तथा AN और PT क्रमशः  माध्यिकाएँ

हैं। यदि  है, त्रिभुज PQR का क्षेत्रफल 150 cm² है और BC = 6 cm है, तो AM और QR

की लंबाई का योग ज्ञात कीजिए।
Ans 1. 38 cm 

2.  36 cm

3. 28 cm 

4.  24 cm

Q.60 किसी त्रिभुज के  कोण (2x+5)°, x° और (3x-17)° हैं। x का मान ज्ञात कीजिए।
Ans 1. 32

2. 48

3. 24

4. 40

Q.61 दिया गया कि 1120.17 = x, 1120.94 = y और xz = y6 है, तो z का मान ज्ञात कीजिए।
Ans 1. 33.18

2. 34.19

3. 32.2

4. 34.73

Q.62
एक अर्धगोलाकार कटोरे  में पानी है। यदि 2 cm त्रिज्या की एक गेंद को कटोरे  में डाला

जाता है, तो पानी का स्तर कटोरे  की ऊँ चाई तक बढ़ जाता है और कटोरे  से कोई अतिरिक्त पानी बाहर
नहीं  गिरता। कटोरे  की त्रिज्या ज्ञात कीजिए।

Ans 1. 4 cm

2. 2 cm

3. 8 cm

4. 6 cm

Q.63 a2 x2 + a3/2x + 3 = 0 के  लिए ‘a’ के  सभी संभावित मानों  का गुणनफल ज्ञात कीजिए ताकि यह एक
द्विघात समीकरण हो, जिसका विविक्तकर 28a हो।

Ans 1. 14

2. 0

3. -12

4. -28

Q.64 यदि X और Y दो ऐसे समुच्चय हैं कि X ∪ Y में 56 अवयव हैं, X में 45 अवयव हैं और Y में 33 अवयव हैं, तो
X ∩ Y में कितने अवयव हों गे?

Ans 1. 22

2. 25

3. 19

4. 13

Q.65 निम्नलिखित को सरल कीजिए।

Ans 1. 1

2. 0

3. 2

4. −1
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Q.66 यदि एकसमान चुंबकीय क्षेत्र किसी पृष्‍ठ के  तल के  समानांतर है, तो पृष्‍ठ के  माध्यम से चुंबकीय फ्लक्स
_______ होता है।

Ans 1. अधिकतम का आधा

2. अधिकतम

3. अनंत

4. शून्य

Q.67 विशिष्ट प्रतिरोध (प्रतिरोधकता) का SI मात्रक क्या है?
Ans 1. ओम प्रति वर्ग मीटर (ohm per square metre)

2. ओम (ohm)

3. ओम-मीटर (ohm-metre)

4. ओम प्रति मीटर (ohm per metre)

Q.68 यदि प्रतिरोध स्थिर रहते हुए किसी प्रतिरोधक के  सिरों  के  बीच विभवांतर दोगुना कर दिया जाए, तो
उपभुक्त शक्ति ______ हो जाएगी।

Ans 1. दोगुनी

2. एक-चौथाई

3. चार गुनी

4. आधी

Q.69 यदि किसी विद्यु त क्षेत्र में रखे गए 2 C आवेश पर 10 N का बल लगता है, तो उस बिंदु  पर विद्यु त क्षेत्र का
परिमाण क्या होगा?

Ans
1. 

2. 

3. 

4. 

Q.70 परिपथ आरेख में प्रतिरोधक को दर्शाने के  लिए किस प्रतीक का उपयोग किया जाता है?
Ans 1. ज़िग-ज़ैग रेखा

2. दो समांतर प्लेटें

3. सूचक सहित वृत्त

4. तीर का निशान

Q.71 निम्नलिखित में से कौन-सा विकल्प, किसी बिंदु  पर विद्यु त क्षेत्र को सटीक रूप से परिभाषित करता है?
Ans 1. प्रति इकाई क्षेत्रफल ऊर्जा

2. प्रति इकाई आवेश पर लगने वाला बल

3. प्रति इकाई आवेश उपलब्ध ऊर्जा

4. प्रति इकाई द्रव्यमान पर लगने वाला बल

Q.72 एक कू लॉम आवेश लगभग _______ के  आवेश के  बराबर होता है।
Ans 1. 6×1018 इलेक्ट्रॉ न

2. 6×1012 इलेक्ट्रॉ न

3. 6×1010 इलेक्ट्रॉ न

4. 6×106 इलेक्ट्रॉ न

Section : Basic Science and Engineering
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Q.73 तापमान में वृद्धि होने के  साथ अर्धचालक की प्रतिरोधकता कम हो जाती है क्योंकि __________।
Ans 1. बैंड अंतराल बढ़ जाता है

2. जालक कं पन रूक जाते हैं

3. इलेक्ट्रॉ न ऊर्जा ह्रास करते हैं

4. अधिक आवेश वाहक उत्पन्न होते हैं

Q.74 इनपुट सिग्नल 4Vp-p, 1KHz आवधिक ज्यावक्रीय ac सिग्नल से जुड़े R-L-C श्रेणी परिपथ के  लिए और
CRO की मदद से मापने वाले प्रतिरोधी R में वोल्टता पात एक ज्यातरंग प्रदर्शित करता है जो 2 इकाइयों
की कु ल ऊं चाई और 1V पर वोल्ट / div knob को ओक्युपाई कर लेता है, तो R = 10Ω होने पर परिपथ के
लिए RMS धारा लगभग ________________ होगी।

Ans 1. 0.071A

2. 0.71 A

3. 1.414A

4. 0.14 A

Q.75 8051 माइक्रोकं ट्रो लर का पोर्ट 0, मुख्यतः  अन्य पोर्ट से संरचनात्मक रूप से (architecturally) अलग
होता है क्योंकि ______________।

Ans 1. यह बिट-एड्रे सेबल (bit-addressable) नहीं  है

2. यह आउटपुट पोर्ट के  रूप में कार्य नहीं  कर सकता है

3. इसमें आंतरिक ऊर्ध्व (pull-up) प्रतिरोधक नहीं  होते हैं

4. यह के वल मेमोरी विस्तार (memory expansion) के  लिए रिजर्व है

Q.76 यदि CRO का time/div नॉब 2 ms/div पर है तथा आवर्त्ती त्रिकोणीय सिग्नल (periodic triangular
signal) का धनात्मक अर्ध चक्र X-अक्ष पर 2 यूनिट का उपयोग करता है, तो सिग्नल की काल अवधि
__________ होगी।

Ans 1. 4 ms

2. 16 ms

3. 8 ms

4. 2 ms

Q.77 8051 माइक्रोकं ट्रो लर में, PSEN एक _____ आउटपुट सिग्नल है, जिसका उपयोग _____ मेमोरी तक
पहुँचने के  लिए रीड स्ट्रोब के  रूप में किया जाता है।

Ans 1. सक्रिय उच्च, बाह्य प्रोग्राम (active high, external program)

2. सक्रिय निम्न, आंतरिक रैम (active low, internal ram)

3. सक्रिय निम्न, बाह्य प्रोग्राम (active low, external program)

4. सक्रिय उच्च, आंतरिक रैम (active high, internal ram)

Q.78 1 m लंबाई का एक सीधा चालक, जिसमें 5 A की धारा प्रवाहित हो रही है, 0.2 T के  चुंबकीय क्षेत्र के
लंबवत रखा गया है। चालक पर लगने वाला बल ज्ञात कीजिए।

Ans 1. 0.04 N

2. 1.0 N

3. 0.2 N

4. 5.0 N

Q.79 एक तर्क  फलन F = ABC + DE द्वारा दिया गया है। आपको के वल दो इनपुट वाले AND गेट और NOT
गेट का उपयोग करने की अनुमति है। इस फलन को लागू करने के  लिए न्‍यूनतम कितने दो इनपुट वाले
AND गेट तथा NOT गेट की आवश्यकता होगी?

Ans 1. 3 AND गेट तथा 3 NOT गेट

2. 2 AND गेट तथा 1 NOT गेट

3. 3 AND गेट तथा 2 NOT गेट

4. 4 AND गेट तथा 3 NOT गेट
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Q.80 समांतर संबंध में, यदि एक प्रतिरोधक टू ट जाता है (खुला परिपथ), तो _____।
Ans 1. बैटरी खराब हो जाती है

2. संपूर्ण परिपथ कार्य करना बंद कर देता है

3. अन्य शाखाएं  कार्य करती रहती हैं

4. वोल्टेज शून्य हो जाता है

Q.81 चुंबकीय क्षेत्र में धारा वाही चालक पर लगने वाला बल अधिकतम तब होता है जब _________।
Ans 1. धारा चुंबकीय क्षेत्र के  लंबवत हो

2. चुंबकीय क्षेत्र शून्य हो

3. धारा चुंबकीय क्षेत्र के  समानांतर हो

4. धारा चुंबकीय क्षेत्र के  विपरीत दिशा में हो

Q.82 ओम का नियम तब लागू नहीं  हो सकता जब _____।
Ans 1. चालक धात्विक हो

2. पदार्थ रै खिक V–I संबंध का पालन करता हो

3. चालक का तापमान स्थिर रहता है

4. चालक का तापमान बढ़ जाए

Q.83 एक PNP ट्रां जिस्टर में, कलेक्टर-बेस रिवर्स बायस में वृद्धि से कलेक्टर धारा में थोड़ी वृद्धि होती है, भले ही
एमिटर धारा स्थिर रखी जाए। ऐसा मुख्य रूप से किसके  कारण होता है?

Ans 1. उत्सर्जक इंजेक्शन दक्षता कम हो जाती है

2. ह्रास क्षेत्र के  विस्तार के  कारण कलेक्टर प्रतिरोध कम हो जाता है।

3. कलेक्टर क्षेत्र में रिक्‍तिका गतिशीलता में वृद्धि होती है।

4. कलेक्टर-बेस वोल्टेज के  साथ प्रभावी बेस चौड़ाई कम हो जाती है।

Q.84 यदि 3 C का आवेश 3 सेकं ड में 15 V के  विभवांतर को क्रॉस कराता है, तो इस प्रक्रिया में उत्पन्न शक्ति
कितनी होगी?

Ans 1. 10 W

2. 30 W

3. 15 W

4. 5 W

Q.85 जब 2-इनपुट वाले NAND गेट के  दोनों  इनपुट को एक साथ जोड़कर एकल इनपुट A बनाया जाता है, तो
परिणामी परिपथ किस लॉजिक गेट की तरह व्यवहार करता है?

Ans 1. NOT गेट (इन्वर्टर)

2. XOR गेट

3. AND गेट

4. OR गेट

Q.86 दो प्रतिरोधक, 6 Ω और 3 Ω, समांतर क्रम में संयोजित हैं। कु ल प्रतिरोध ज्ञात कीजिए।
Ans 1. 2 Ω

2. 9 Ω

3. 4 Ω

4. 1 Ω

Q.87 SI पद्धति में निम्नलिखित में से कौन-सी मौलिक (आधार) राशि है?
Ans 1. कार्य

2. द्रव्यमान

3. दाब

4. बल
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Q.88 चुम्बकीय अभिवाह, ________ पर निर्भर करता है।
Ans 1. के वल चुंबकीय क्षेत्र

2. क्षेत्रफल, B का परिमाण और उसका अभिविन्यास

3. के वल क्षेत्रफल

4. के वल कोण

Q.89 पृथ्वी पर 5 kg की वस्तु पर लगभग 49 N का गुरुत्वीय बल लगता है। इससे यह तात्पर्य है कि प्रयुक्त g का
मान लगभग _______ होगा।

Ans 1. 19.6 m/s²

2. 2 m/s²

3. 9.8 m/s²

4. 4.9 m/s²

Q.90 निम्नलिखित में से कौन-सा कथन भार का सटीक वर्णन करता है?
Ans 1. भार की कोई दिशा नहीं  होती है

2. भार को किलोग्राम में मापा जाता है

3. भार में परिमाण और दिशा दोनों होते हैं

4. भार के वल यह दर्शाता है कि कोई वस्तु कितनी भारी है

Q.91 समान पदार्थ के  दो चालकों  की लंबाई L और 2L है और प्रतिरोध समान है। उनके  अनुप्रस्थ-काट क्षेत्रफलों
का अनुपात (A₁:A₂) क्या है?

Ans 1. 1:4

2. 4:1

3. 2:1

4. 1:2

Q.92 निम्नलिखित में से कौन-सी मात्रा ब्रह्मांड के  सभी स्थानों  पर समान रहती है?
Ans 1. आभासी भार

2. भार

3. गुरूत्वीय बल

4. द्रव्यमान

Q.93 निम्नलिखित में से कौन-सा पदार्थ विद्यु त परिपथों  में एक अच्छे  विद्यु त्-रोधी के  रूप में कार्य करता है?
Ans 1. ग्रेफाइट

2. प्लास्टिक

3. लोहे की छड़

4. पारा

Q.94 त्रिज्या r का एक वृत्ताकार लूप एकसमान चुंबकीय क्षेत्र  में रखा गया है। यदि लूप का तल क्षेत्र के  लंबवत
है, तो लूप से होकर गुजरने वाला चुंबकीय फ्लक्स ______ होगा।

Ans 1. 2πr2B

2. πr2B

3. Br

4. 2πrB

Q.95 दो ट्रां जिस्टर अभिनतिकरण परिपथों  के  स्थायित्व गुणक S₁ = 101 और S₂ = 15 हैं। इनमें से कौन-सा
परिपथ बेहतर उष्मीय स्थायित्व प्रदान करता है?

Ans 1. परिपथ 2

2. तुलना नहीं  की जा सकती है

3. दोनों का स्थायित्व समान है

4. परिपथ 1
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Q.96 जब कई प्रतिरोधकों  को श्रेणी क्रम में जोड़ा जाता है, तो किस भौतिक राशि (physical quantity) का
मान प्रत्येक प्रतिरोधक के  लिए समान होता है?

Ans 1. प्रतिरोध

2. धारा

3. वोल्टता

4. शक्ति

Q.97 एक 10 Ω का प्रतिरोधक किसी स्थिर वोल्टता स्रोत से संयोजित है। जब इसके  साथ श्रेणीक्रम में एक और
प्रतिरोधक संयोजित किया जाता है, तो परिपथ में धारा अपने प्रारं भिक मान की आधी हो जाती है। यह
मानते हुए कि आपूर्ति वोल्टता अपरिवर्तित रहती है, दू सरे  प्रतिरोधक का प्रतिरोध ज्ञात कीजिए।

Ans 1. 10 Ω

2. 15 Ω

3. 5 Ω

4. 20 Ω

Q.98 यदि अन्य मापदंडों  को स्थिर रखते हुए, होल्स (holes) की गतिशीलता को उसके  मूल मान के  आधे तक
कम कर दिया जाए, तो p-टाइप अर्धचालक की चालकता _________।

Ans 1. स्थिर रहेगी

2. घटकर आधी हो जाएगी

3. तीन गुनी हो जाएगी

4. दोगुनी हो जाएगी

Q.99 एक आदर्श अर्धतरंग दिष्टकारी, एक ज्यावक्रीय स्रोत से विशुद्ध रूप से प्रतिरोधी लोड की आपूर्ति करता
है। मान लीजिए vL(t) लोड वोल्टता है तथा vD(t) डायोड वोल्टता है, जिसे एनोड के  संदर्भ में मापा जाता
है। निम्नलिखित में से कौन-सा कथन एक पूर्ण चक्र में सदैव सत्य होता है?

Ans 1. vD(t) का औसत मान शून्य है क्योंकि डायोड आधे चक्र के  लिए चालन करता है।

2. vD(t) का rms मान स्रोत वोल्टता के  rms मान के  बराबर होता है।

3. डायोड का अभिविन्यास उत्क्रमित करने पर vD(t) का औसत मान शून्य हो जाता है।

4. vL(t) और vD(t) के  औसत मान परिमाण में बराबर और चिन्ह में विपरीत होते हैं।

Q.100 कौन-सा उपकरण (device) विद्यु त चुम्बकीय प्रेरण के  माध्यम से यांत्रिक ऊर्जा को विद्यु त ऊर्जा में
परिवर्तित करता है?

Ans 1. संधारित्र

2. बैटरी

3. विद्यु त जनित्र

4. विद्यु त मोटर
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